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Resolving Pro-Stitcher Issues
This document will cover error conditions that may occur with Pro-Stitcher®.  It is not a guide to instruct 
you on how to use Pro-Stitcher.  See MK Quilts University for hours of popular video training to help 
you learn how to use Pro-Stitcher.

It is important to understand that Pro-Stitcher is more than just the Windows tablet that runs the 
Pro-Stitcher software.  The important work is done by the motors in the carriage that moves the ma-
chine.

This guide is written to address only Pro-Stitcher Premium.  If you are running a very old version of 
Pro-Stitcher, you may be running the Pro-Stitcher Standard or Pro-Stitcher Classic instead of Pro-Stitch-
er Premium.  At the time of this writing, the current version of Pro-Stitcher is 537.

Note: This is not an official Handi Quilter Document.  All information contained in this document 
is the responsibility of MK Quilts.  Recommendations for changes should be emailed to webmaster@
mkquilts.com.

The following issues and their probable solutions are discussed in the following sections.

1. Pro-Stitcher will not power up and boot correctly
2. Pro-Stitcher not communicating and no errors indicated
3. Installing/repairing Pro-Stitcher
4. Communication and motor errors
5. Hard failures
6. Intermittent failures
7. Design does not display on Pro-Stitcher screen
8. Miscellaneous issues

1. Pro-Stitcher Will Not Power Up and Boot Correctly
Sometimes your tablet does not seem to power up correctly, or the Pro-Stitcher application does not 
boot correctly.  Try the following steps to resolve your problem.

Note: This section does not cover the “USB Communication Error” you get when booting if the tablet 
cannot communicate with the machine or carriage.  Pressing “Ignore” will bypass the USB error and al-
low Pro-Stitcher to start, however Pro-Stitcher will indicate a motor error is present.  See “Communica-
tion and Motor Errors” in a later section of this document for this situation.  (If you are running PS-Lite, 
you will not have an “Ignore” option.  Instead, you will be given the option of starting in Simulation 
mode.)

1. Confirm that you have power charging the tablet.  The Handi Quilter machine must be on.  If 
the tablet’s battery power is extremely low, it may continue to shut itself off.  Look for a blue or 
orange power light on the tablet.  This power light is usually on the power button, but is now in 
the top right area of the newer Chuwi tablets.

2. If you see nothing on the screen when the blue light comes on:

a. Attempt to hold the power button down until the blue light goes off.  Do not press and re-
lease the power button.  Pressing and releasing will often put a tablet in a sleep mode in-



2

Resolving Pro-Stitcher Issues

© 2023 by MK Quilts.  All rights reserved.

stead of rebooting.  Holding the button for 15-20 seconds will cause most computers to turn 
off their power supply.  This is known as a hard reboot.

b. Turn on the tablet by pressing the power button for 3-4 seconds.  The blue light should come 
on.

c. If nothing continues to be displayed on the screen, repeat steps a and b up to 5 times.

d. If the problem continues, unplug the power from the tablet and leave the tablet running with 
the blue light lit for at least 8 hours or until the light goes out.  (Some models of tablets are 
rumored to have had some faulty battery charging hardware that will automatically reset if 
the battery is left to discharge.)  Then recharge and try to reboot the tablet.

e. If recharging the tablet and repeating the above steps does not work, there is a small chance 
that the tablet backlight is not working and that the tablet is running without the display 
working.  Handi Quilter tablets are warrantied for only 2 years and are costly to replace.  You 
will need to call Handi Quilter support directly (877-697-8458, press #2) and let them walk 
you through the above process before they will swap out a tablet.  In most cases, they will 
request that the tablet be shipped to them for repair or replacement.  (Speak to MK Quilts 
about a loaner tablet, if needed.)

3. Make sure that you are in desktop mode.  Do not put your tablet in tablet mode.  Pro-Stitcher is 
written as a standard Windows application and not as a tablet application.

a. Make sure your tablet is not coming up in tablet mode.  Desktop mode should be the default.  
The mode is found in the lower right icons on the tool bar in Windows 10.

b. Some earlier tablets that are running an operating system prior to Windows 10 may come up 
and require you to set desktop mode.

c. Tablets with Windows 8/8.1 can be confusing because they temporarily adopted the tablet-
looking start menu.  You may get an icon that says “Desktop”.  Selecting this icon should 
allow Pro-Stitcher to start.

4. If Pro-Stitcher hangs or does not appear and you end up at a Windows desktop, try pressing 
the Pro-Stitcher icon to start Pro-Stitcher.  If the problem persists, please repair or re-install the 
Pro-Stitcher application as described in a later section of this guide.

Example of Tablet Mode
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5. If Pro-Stitcher fails to start and you are taken back to the Windows desktop, make sure you have 
the latest video driver loaded that supports OPEN_GL.  This problem should only happen if you 
recently re-installed your operating system and have not loaded the hardware-specific drivers.  If 
this is the case, the Event Viewer will show an Open_GL error from .NET.

6. If you have to ship your tablet to Handi Quilter to be “re-imaged”, you may incur a charge that 
is not covered by warranty.  The Pro-Stitcher should never be put on a network.  Standard 
Windows updates that normally occur over a network might lead to uncertain problems with 
Pro-Stitcher operation because they have not been tested by Handi Quilter.  Software updates for 
Pro-Stitcher will include operating system updates when necessary and should only be applied 
using a USB offline method.  (This does not apply to running Simulation Mode on your personal 
Windows computer.)

2. Pro-Stitcher Not Communicating and No Errors 
Indicated
If the Pro-Stitcher Needle Up/Down button on the tablet does not trigger a stitch on your machine, the 
tablet is not talking to the machine.  If there are cable issues, you will normally get indications of other 
errors and the icons at the bottom of the screen would not be green.  If everything looks ok, confirm you 
are not in simulation mode.

• The icon at the top right of the screen should not have an “S” above the “Motors” text.  If your 
tablet does show an “S”, go to Configuration (the gear icon in the top right of the screen), then 
touch the Advanced tab, then touch General.

• In the selection pane on the right side of the screen, turn off “Simulation On/Off ”, so that it is 
not highlighted in green.  Then, reboot the tablet.

Pro-Stitcher in Simulation Mode
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3. Installing/Repairing Pro-Stitcher
This section assumes that you do not have a working copy of Pro-Stitcher running.  If Pro-Stitcher will 
run, many of the steps that require use of the File Explorer program can be done using the “Update” 
button on the File tab of Pro-Stitcher.

MK Quilts uses commercial remote support software that can access a computer that is on the internet 
to do the actual installation and repair on your personal computer (presuming you grant remote access 
of your computer to MK Quilts).  There is no way, however, to access the Pro-Stitcher tablet on the ma-
chine directly.  (As mentioned earlier, the Pro-Stitcher tablet should never be put on a network.)  Video 
chats between you and MK Quilts can be used to help facilitate troubleshooting, but you will need to 
operate the tablet.

It is recommended that you have a stylus (pen) made for touching a computer screen.  This will help 
accommodate those with large or dry fingers, since some of the troubleshooting actions may otherwise 
be difficult.  You may also want to consider attaching a USB keyboard and mouse to your tablet while 
you are performing these tasks.

3.1 Download the Pro-Stitcher Software
There are many training videos available on downloading and updating the Pro-Stitcher software.  Pay 
attention to the date of the recording to ensure it is providing up-to-date information, as things do 
change.  This document will be kept high-level.  If you need assistance, book a support call with MK 
Quilts, and we can get on your personal computer remotely and help download and extract the required 
software to a USB storage drive/key.  We can talk you through taking that USB key to the tablet and 
doing the install.

1. Download the latest production version of Pro-Stitcher. (Currently, this is version 537 for most 
models.)  To download the software update, go to https://prostitcher.com/prostitcher-software-
update/

2. Once downloaded, decompress the files to a USB drive. You should have two files in the root 
directory of the USB drive:
• PsPreInstall.18.02.0012.exe
• PsPUpdate.21.07.0537_P.exe

3. Remove the USB drive from your personal computer.  If you give it time to complete writing 
before you pull the USB drive, you should not need to use the “Eject” feature.

3.2 Install the Pro-Stitcher Software
1. A complete reset is not required in most cases and should only be used as a last resort.  Handi 

Quilter did not provide an uninstall option, so we can go into the file system and rename key 
directories to remove any corruptions. (We do not touch the patterns in C:/Designs.)
a. If Pro-Stitcher is running, choose the Exit to Windows option.  Close any apps that you see 

running, including the PsStop process.  Right-click and close anything that might have a pro-
gram running for Pro-Stitcher.

b. Bring up the File Manager and turn on View->Hidden Files.  Rename the folder (directory) 
“C:\ProgramData\Pro-Stitcher” to be “C:\Program Files\Pro-Stitcher.old”.
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c. If you get an error message, it is likely that some process is still running for Pro-Stitcher.  
Open the Task Manager and close or end any process(es) related to Pro-Stitcher.

d. Reboot the tablet.
e. Proceed with a fresh install, as follows.

2. Install the USB drive into one of the active ports in the Pro-Stitcher hub.  On all systems except 
the Infinity, the ports are built into the tablet mount on the machine.  Do not attempt to use the 
other USB ports that are on the actual machine.  If you have an Infinity, the ports are built into 
the front left side of the machine near the front power switch.
a. USB Hubs - Although you can use an external USB hub device to provide more ports, it is 

recommended that you disconnect accessories that are getting power from any hub plugged 
into the Pro-Stitcher ports.  Over-taxing the USB ports with too many devices requiring 
power can cause USB errors.  You may disconnect the USB cable from the tablet and directly 
plug the USB drive into the tablet, since it does not need to speak to the machine during the 
installation.

b. Remove any other USB Drives (keys, flash drives, or other).

3. Open the File Explorer program (the yellow folder icon).  You should see two sections/panes be-
neath the menus at the top.  The look can vary here, depending on the view options that are set.  
We recommend the “Details” or “Medium Icons” view setting, with the Navigation pane (left 
side) enabled, but not the Preview or Details pane.  Note that each folder can be set with differ-
ent view settings, which can make things confusing.  At the machine tablet, you will be dealing 
with the File Explorer in desktop mode, which will make it more challenging to touch the correct 
item.  Use of a stylus is recommended.

4. Select and run each of the following program files in order:

a. PsPreInstall.18.02.0012.exe
1) This installs operating system files and libraries required by Pro-Stitcher.  If a message 

appears that states that the item has already been installed or there is a later version, you 
can safely bypass it.

2) If the “Repair” button appears, select it.
3) Do not reboot when suggested.  Let the PsPreInstall program complete its installation.  

Once you hit the Close button, use the Windows menu to reboot.

b. PsPUpdate.21.07.0537_H.exe
1) This is the most recent and stable version of Pro-Stitcher as of the writing of this docu-

ment.  We recommend starting here to make sure your system is running properly before 
you update to a later version.

2) If the “Repair” button appears, select it.  This will force a reset/reload.
3) Pro-Stitcher will start itself after the install.  Give it time to start.

5. Once you have confirmed that Pro-Stitcher is operating and communicating with your hard-
ware, you can use the “Update” button within Pro-Stitcher to update to a later version.  Note that 
later versions change the C:/Designs folder structure.  Recent versions since version 506 include 
later versions of patterns, and you may see that some patterns have changed from HQF to HQV 
format within the folders.
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4. Communication and Motor Errors
The Pro-Stitcher tablet must communicate with the machine and the Pro-Stitcher carriage.  This is done 
through the USB port on the tablet.  The tablet and carriage communicate to move the machine around.  
The machine stitches based on the settings and the input of the encoders.  So basically, the machine 
only provides settings and handlebar functions.  Once the start button is pressed and the message to 
start is passed to the machine, the Pro-Stitcher tablet is controlling the motor that is moving the ma-
chine around the frame.

If you reboot the tablet and get an error message with the option to “ignore” as Pro-Stitcher is starting, 
this indicates a hard failure of the USB communication path.  If you reboot and get proper motor con-
trol, but while using it, you get a motor error, this indicates an intermittent failure.

5. Hard Failures
Following are some steps to help you troubleshoot hard failures with Pro-Stitcher.

1. Are your machine and carriage plugged in and powered on?  Check for lights, LEDs, and sound.  
If things are functioning properly, pressing the handlebar up/down button should cause the nee-
dle bar to move.  Most machines have power buttons on the back and front.

2. Under the Pro-Stitcher tab, press the Full-Stitch button on the Pro-Stitcher screen.  If the needle 
stitches, there is communication with the machine through the front connections.  If so, immedi-
ately check the rear cables and power to the carriage.

3. Remove any external USB memory sticks or devices from the USB ports on the hub on the 
Pro-Stitcher mount.  Too many devices plugged in can pull too much power and cause all con-
nected devices to fail.

4. Check all cables.  Unplug and re-plug each end of each cable.

a. Amara/Forte/Infinity, (internally cabled machines):  The 3- or 4-wire connector plugs into 
the back of the machine and must be secured by a plastic restraint to prevent repeated flexing 
of the wires at the connector and subsequent cable failure.  The other end of the cable will go 
to the back of the carriage drive tray. (See photo below.)

Cable with Plastic Restraint
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b. Older systems with external cabling:  Some very old systems have a cable hard wired to the 
carriage drive tray, otherwise there will be a connector with two screws.  There is a small 
two-wire cable going to the Y-encoder on the side of the machine.  Pulling this cable too hard 
can cause the mounting connector on the board to separate.

c. At the back of the hub on the tablet mount, you will have a power lead and two identical 
D-sub connectors marked #1 and #2.

d. The power cable to the Pro-Stitcher should be checked.  Very old carriages had the power 
cable loop under the carriage and plug into a power supply block.  Some later systems used 
a short jumper cord that went from the machine to the carriage.  The latest configuration 
consists of separate cords for the machine and carriage.

e. Check for power at the tablet by reducing or closing the Pro-Stitcher software and checking 
the Windows battery indicator to confirm that it is charging.  Unplugging the power cable 
from the tablet should cause the indicator to change and sometimes the tablet screen will 
dim.

f. Check the USB port of the tablet.  Unplug the USB cable from the tablet port and insert a 
USB memory stick.  If the volume is turned up on the tablet, there should be a tone as it is 
detected.  Use the Windows File Manager or Pro-Stitcher software to access the USB stick.

g. Check the USB cable between the tablet and the hub.  You will also hear a tone when you 
connect the cable if it detects the motors.  (You can simulate/trigger a motor error by unplug-
ging this cable under normal operating conditions.)  The Pro-Stitcher tablet may need to be 
rebooted after the connection is restored.

h. Amara/Forte/Infinity, (internally cabled machines):  There is both a power and a USB cable 
that will run from the hub to the machine.  On the Amara/Forte, you will need to open the 
front plastic cover with a 3mm hex tool to get to the connections.  Examine the connection 
points and look for any pinched wires leading into the front of the machine.  Do not pinch 
the wires with the plastic cover as you close it.

5. Attempt to use the machine in manual/regulated mode using the handlebars.  If you can do regu-
lated stitching, the machine is likely ok.  A call to Handi Quilter may be required to determine if 
an internal board has failed.  Work with your retailer to make the call.

The most common cause of motor errors on the Amara and Forte is the lack of the cable restraint on the 
Pro-Stitcher cable.

6. Intermittent Failures
Following are some intermittent failures and their possible solutions.

1. Is your torque setting set to 300?  To edit or set the torque setting, go to Settings (gear)->Ad-
vanced->Motors menu.  Older motors can start to draw more current/power, leading to tripping 
the torque limit.  (This issue is likely pertinent only to Pro-Stitcher versions 506 and earlier.)

2. Amara/Forte:  Is the cable from the carriage to the back of the machine properly restrained?  
Improper or lack of cable restraint is the leading cause of cable failure.  There should be as little 
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amount of cable as possible between the bracket screwed to the machine and the point where the 
four-wire cable plugs into the machine.

3. Check all the cables as indicated in the “Hard Failures” section above.

4. Make sure that cables are not catching as the machine is moved forward and back on the car-
riage.

5. Take the needle and thread out so you can run some machine tests without impacting a quilt.
a. Try to reproduce the issue by running the Pro-Stitcher pattern while stitching (without a 

needle).  Do not ghost stitch.
b. Try a different pattern.
c. Try different areas on the table.
d. Manually wiggle cables while running the machine.
e. Change the speed and acceleration settings.

6. Clean thread and dirt from the gears and wheels on the carriage.

7. Design Does Not Display on Pro-Stitcher Screen
There are two conditions of which we are aware that will cause the design not to show up.

1. The View->Design button is not highlighted.  This is the first place to check.

2. The Pro-Stitcher configuration file has been corrupted.  Ignore the design.  Simply enable the 
Grid feature and zoom in and out to see the squares and lines.  If everything disappears and you 
only have a white screen, you have an issue.

You can reinstall both the PRE-* and Update* files for your current version of Pro-Stitcher using the 
“Repair” button.  (See previous section on the installation of Pro-Stitcher software.)  If that does not 
work, you need to shut down Pro-Stitcher, delete the config file, and reboot the tablet.  If you are not 
comfortable performing the steps below, please schedule a support call with your retailer or MK Quilts.

1. Exit To Windows:  Via the File->Shutdown button, select the “Exit to Windows” option.
2. Open a File Explorer using the yellow folder icon on your taskbar.  On older tablets, you may 

have to search for it.
3. In File Explorer, under the View tab/menu, make sure that “show hidden items” is selected.  This 

varies between Windows 10 and Windows 11.  You will know it is correct when you go to the 
root “C:” drive and you can see the ProgramData folder.
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4. Click down into the ProgramData folder until you get to C:\ProgramData\Pro-Stitcher\Data, 
and delete the “settings.hqdb” file.

5. Do not restart Pro-Stitcher.  Reboot the tablet using the Windows Start menu.

This will reset the Pro-Stitcher configuration.  You will have to reset your custom button assignments 
and enable “Touch” under the Config (gear)->Display settings.

8. Miscellaneous Issues
8.1 Cannot Access a USB Drive on the Pro-Stitcher

1. Make sure you are plugging into the USB port on the Pro-Stitcher tablet mount.  Except on 
Infinity, the USB ports that are on the physical machine are there for power only.  They do not 
communicate with the tablet.

2. Make sure that you do not have too many devices plugged into the USB Hub.  The combined 
power requirements could result in failure of all devices.  This will usually lead to motor/
communications errors for the Pro-Stitcher as well.  There are USB hubs with external power 
supplies that can help resolve this issue.

8.2 Pro-Stitcher Installation Issues
1. The squares of the grid do not look square.  This is due to Pro-Stitcher not detecting the screen 

size properly.
a. Go to the Settings (gear) tab, then Display.
b. Confirm that the Monitor Width and Height are set to the visible (not physical) screen 

dimensions.  Do not measure diagonally.  Measure in inches from the visible screen edges.
c. Make sure the “Touch” button is enabled.
d. Restart Pro-Stitcher if the grid does not automatically resize.

2. There are no designs.  This is not a bug.  It is a feature.  Use a USB drive to copy the C:\Designs 
folder from your tablet or the USB stick that came with your Pro-Stitcher.
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8.3 Pro-Stitcher Designer Software Licensing
Licensing Designer is overly complicated.  Please download and print out the instructions found on the 
Pro-Stitcher website (www.prostitcher.com).  Schedule a support call with MK Quilts to assist you with 
your licensing, especially the offline licensing process.


